Installation Guide
for the
Intel® Server Control

Order Number: 747116-011

This guide explains how to install and launch the Intel® Server Control (1SC) software. I1SCisa
server management tool that provides real time monitoring and alerting for server hardware,
emergency remote management, and remote server setup. It isimplemented using a client-server
architecture.
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Platform Compatibility

Feature availability can depend on which version of the Inted® Server Control (ISC) is running on
which platform. Specifically, compatibility is an issue when an ISC 3.1 console is managing a
network of systems that are running older versions of I1SC. For feature availability, refer to the
Platform Compatibility Matrix beginning on page 23 near the end of this guide.



System Requirements

ISC contains two parts:

e |SC Console Software
e |SC Server Instrumentation Software

ISC Console Software alows interaction with the managed server. It can beinstalled on these
system configurations:

» Windows NTT 4.0 server or workstation, Enterprise Edition

»  Windows' 98 Second Edition workstation

*  Windows 2000 workstation

ISC Server Instrumentation Software, when installed, creates a managed server that can be
managed from the system running 1SC Console Software. It can beinstalled on these systems:
e Windows NT 4.0 server

*  Windows 2000 server

+ NeWare' server

» UnixWare' server

« Linux' 6.2 server

Managed Server Requirements

ISC supports severa Intel® motherboards. For a complete list of supported server motherboards
and qualified BIOS revision levels, seethe files README.TXT and ERRATA.TXT. You can find
thesefile in the appropriate language directory of the Docs directory on the Software Kit CD. The
following requirements must be met for a managed server.

Windows 2000/NT Requirements

*  Windows 2000 Advance Server, NT Server 4.0 (SP 6a), or Enterprise Edition

* 64 MB of RAM

* 60 MB of availabledisk space

*  Windows NT SNMP or SNMP service installed (required only for connectivity to an SNMP
management console)

NetWare Requirements

* NetWare4.2 SP8aor 5.1 SP1 symmetric multiprocessing (SMP)
* Atleast 95 MB of RAM
» Atleast 60 MB of available disk space
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Red Hat Linux Requirements

If you intend to manage a Linux file server, it must meet the following minimum requirements:

* RedHat Linux 6.2 SBE 2 running in multiple-processor kernel
+ 32MB of RAM
* 60 MB of available disk space

SCO UnixWare Requirements

If you intend to manage a UnixWarefile server, you must have an account with root privileges
availableto you. The server must also meet the following minimum requirements:

e SCO UnixWarev7.1.1

e 32MB of RAM

* 60 MB of available disk space

Additional Requirements for DMI-SNMP Translation

Simple Network Management Protocol (SNMP) support must beinstalled if you want to integrate
ISC with an SNM P-based management framework. For SNMP installation information, see your
Windows NT, NetWare, or UnixWare documentation.

On the managed server, you should consider the following issues when configuring SNMP:

*  Community string names for SNMP Get and Set operations
»  Community string names for sending traps
*  The destination address for the management consol e receiving the traps

On the management console, you should consider the following issues when configuring SNMP:

*  Compiling the MIBs into the SNM P management consoles
* Integration of 1SC traps into SNMP management consoles

Console Requirements

Console System requirements may change when snapping into one of the supported management
applications. Pleaserefer to their installation requirements for additional information.

I SC Console Software integrates into an Enterprise System Management Console or it can be
installed on a stand-alone console. The required Enterprise System Management Consoles are:

1. Intel® LANDesk® Server Management 6.xx
2. HP OpenView' Network Node Manager 6 for Windows NT
3. CA Unicenter TNG' 2.2 for Windows NT

A stand-alone console manages | SC-enabled servers without Enterprise System Management. Itis
implemented as an ActiveX T control that runs within its own container or third party container
application (e.g., Microsoft Management Console, Internet Explorert v5.0 or later, or Netscape
Navigatort v3.0 or later with ActiveX ™ snap-in). Y ou can choose the stand-alone environment
during setup. If you do not choose the stand-al one environment and no management consoleis
present, the ISC software will not install.
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Windows 98 Second Edition

e Intel® Pentium® microprocessor or higher.
* Atleast 32 MB of RAM.
» Atleast 10 MB of available disk space.

»  Microsoft Windows compatible modem must be used for if you connect to the server by
modem.

Windows 2000/NT

*  Windows 2000/NT Server, or Workstation 4.0 (SP 6a), or Enterprise Edition.
* Intel Pentium microprocessor or higher.

» Atleast 64 MB of RAM.

» Atleast 10 MB of available disk space.

e For Windows NT, Remote Access Service must also be installed. If it is not installed the Direct
Platform Control (DPC) component will not install.

»  Microsoft Windows compatible modem must be used for if you connect to the server by
modem.
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Service Partition and Population

The service partition is a special hard disk partition. It is established when initially setting up the
server system and contains utilities, diagnostics, and other software required for remote
management. The service partition is not marked as an active partition and the server will only
boot from it by a special request. It is not normally visible to the server user because it hasa
special non-standard partition type that does not appear as an accessible file system to the end user
operating system. However, low level disk utilities can see the partition entry as an unknown type,
and recognize its space.

The utilities and diagnostics on the service partition can berun locally or remotely. Inorder to run
the utilities and diagnostics the server must boot from the service partition. Remote execution is
available from the Direct Platform Control (DPC) Console Manager and System Setup Utility
(SSU) Client.

Service Partition Installation

It is recommended that you install the service partition:

* Onaclean formatted hard drive with no partitions defined.

» Béforeinstalling any operating system.

It can also beinstalled on a hard drive that contains partitions, providing there is unpartitioned
space and one free entry in the partition table. However, these are not recommended because some

operating systems may no longer boot if partitions are added or removed after that OS has been
installed.

Requirements

»  The SP can be on any of thefirst 8 BIOS-supported physical hard drives.

»  SPhard drives must support BIOS INT13.

*  Current ECO BIOS must beinstalled.

* Remove old service parititions and create service partition with current Software Kit CD.

» Atleast 50 MB of unused (not partitioned) hard drive space. On large hard drives this unused
space must be within thefirst 8 GB.

» A service partition does not already exist on the hard drive.

[] NOTE

There are commercial utilities that can resize existing partitions to free space
if moreisneeded. Alternately, you can add a low capacity hard drivefor the
service partition.
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Installation

This procedureis for installing the SP on a clean formatted hard drive only.

A CAUTION
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To prevent data loss, do not attempt to run the installation utility from any
device other than the Software Kit CD.

Backup all dataon all hard drive.

Disable all system features that prevent writing to the hard drive boot sector.

Insert the Software Kit CD into the CD-ROM reader.

Restart the server.

When the “F2 to enter setup” message appears, quickly press F2 to enter Setup.

In Setup, use the arrow keys to select the Boot menu.

Usethe arrow keys to select Boot Device Priority then press Enter.

Select ATAPI CDROM and use the + key to move the selection to the top of thelist.
Press F10.

. Select Yesto confirm saving of the current settings and press Enter. The server restarts and

boots from the Software Kit CD.

When the Server Board CD-ROM menu appears, use the arrow keys to select the Utilities menu
and press Enter.

Select Run Service Partition Administrator and press Enter.

Choose item 3 - Create service partition (first time).

Follow the instructions on your screen to seect the hard drive for service partition installation.
The utility creates the service partition and informs you that it will reboot the server when you
press any key.

The server reboots from the Software Kit CD.

When the Server Board CD-ROM menu appears, use the arrow keys to select the Utilities menu
and press Enter.

Select Run Service Partition Administrator and press Enter.

Choose item 4 - Format service partition and install software.

Follow the instructions on the screen to format the service partition and install the partition
software.

Quit the Server Board CD-ROM menu.

Remove the Software Kit CD from the CD-ROM reader.

Y ou can now install the user operating system.
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Boot the Server from the Service Partition

Boot the server from the service partition when you want to run the utilities and diagnostics found
on the service partition. Y ou can reboot a server:

Locally

Remotely

Using the DPC console manager
Using the Client SSU

Locally Booting the Server from the Service Partition Boot

1

2
3.
4,
5

o

Restart the server.

When the “ F2 to enter setup” message appears, quickly press F2 to enter Setup.

In setup, usethe arrow keys to select the Server menu.

Select Service Boot and press Enter.

Choose Enabled and press Enter. The Service Boot option resets to Disabled after the next
system boot.

Press F10.

Select Yesto confirm saving of the current settings and press Enter. The server restarts and
boot from the service partition.

Remotely Booting the Server from the Service Partition Boot

Y ou can remotely boot the server from the service partition using the DPC Console Manager or the
SSU Client.

Configuring EMP and Console Redirection Settings

To take advantage of DPC and CSSU features, the Emergency Management Port (EMP) and
console redirection settings must be configured using the server System Setup Utility (SSU).

NG A®ODNE

©

10.

11.
12.

Insert the Software Kit CD into the CD-ROM reader.

Restart the server.

When the “ F2 to enter setup” message appears, quickly press F2.

In Setup, use the arrow keys to select the Boot menu.

Usethe arrow keys to select Boot Device Priority then press Enter.

Select ATAPI CDROM and use the + key to move the selection to the top of thelist.

Press F10.

Select Yesto confirm saving of the current settings and press Enter. The server restarts and
boots from the Software Kit CD.

When the Server Board CD-ROM menu appears, use the arrow keys to select the Utilities menu
and press Enter.

Select “Run System Utility” under the “ Utilities” menu. You will see SSU executables
installed the first time and then the Server SSU launches.

Inthe Available Tasks list sdect Platform Event Manager and click OK.

Click the Configure EMP button.
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13. Enter thefollowing in the Emergency Management Port (EMP) dialog box:

Option Entry

Enter New Password: Enter the EMP password, up to 16 characters.

Verify New Password: Re-enter the EMP password.

ESC Sequence: +++ (default)

Hangup String: ATH (default)

Modem Init String: ATE1Q0V1X4&D0S0=0 (default). May require change based on the installed
modem requirements.

System Phone Number: The phone number to access the EMP port connect to port COM2.

Access Mode: Always Active. [default is Preboot]

Restricted Mode: Disable. [default is Enable]

Connection Mode: Modem Connect(default) for modem connections to COM2. Serial Connect

for direct serial connections to COM2.

14. Click Save, then Close.

15. Exit from the Server SSU.

16. Quit the Server Board CD-ROM menu.

17. Removethe Software Kit CD from the CD-ROM reader.
18. Reboot server and select F2 to re-enter BIOS setup.

19. Sdlect Server.

20. Toggle“LAN Redirection” to enable.

21. Press“ESC” and save changes before rebooting.

Configuring the Server for LAN Access

To take advantage of LAN access and BMC LAN-Alerts features, server settings must be
configured using the server System Setup Utility (SSU). After the settings areinitialized they can
be changed using the Client System Setup Utility (CSSU).

If you are going to define a SNMP community, be sure to do it beforeinstalling I SC.

1. Insert the Software Kit CD into the CD-ROM reader.

Restart the server.

When the “ F2 to enter setup” message appears, quickly press F2.

In Setup, use the arrow keys to select the Boot menu.

Usethe arrow keys to select Boot Device Priority then press Enter.

Select ATAPI CDROM and use the + key to move the selection to the top of thelist.

Press F10.

Select Yesto confirm saving of the current settings and press Enter. The server restarts and

boots from the Software Kit CD.

9. When the Server Board CD-ROM menu appears, use the arrow keys to select the Utilities menu
and press Enter.

10. Select “Run System Utility” under the “ Utilities” menu. You will see SSU executables
installed the first time and then the Server SSU launches.

11. Inthe Available Tasks list select Platform Event Manager and click OK.

N A WD
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12. Click the Configure LAN button.
13. Enter thefollowing on the BMC LAN Configuration (LAN) dialog box:

Option
Enable LAN Alerts:
Enter New Password:

Verify New Password:
LAN Access Mode:

SNMP Community String:

IP Configuration:
Host IP Address:
Gateway IP Address:
Subnet Mask:

Alert IP Address:

Entry
Click to enable BMC LAN-alerts.

Enter the BMC LAN Configuration password, up to 16 characters. Default is
NULL. This will be used for all LAN connections in CSSU, DPC, PIC, and
BMC LAN-alerts.

Re-enter the BMC LAN Configuration password.

Full Access, which allows DPC and CSSU access via LAN. By default, LAN
access inside is disabled.

Public (default) unless there is predefined SNMP host to receive SNMP traps
from BMC LAN-Alerts. Must be from 5 to 16 characters.

Static (default) unless you are using DHCP for IP hosting, then select DHCP.
Enter the IP address of the server if you are not using DHCP.
Enter the IP address of the router if you are not using DHCP.
Enter the subnet mask of the hosts on the subnet if you are not using DHCP.

Enter the IP address of the server to receive SNMP traps for the community
defined with the SNMP Community String. Enter 0.0.0.0 (default) if a
community is not defined.

14. Click Save, then Close.
15. Exit from the Server SSU.
16. Quit the Server Board CD-ROM menu.

Using the DPC Console Manager

1. Connect to the appropriate server.
2. Sdlect Reboot Service Partition from the Action menu.

Using the Client SSU

1. Select (Re)Connect from the Server menu.
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Installing I1ISC

Managed Server Preparation

I SC uses the event-logging feature of the BIOS for system management status and information. To
enable this feature for each server to be managed with 1SC, you must boot the server(s) using the
System Configuration Utility (SCU) or System Setup Utility (SSU) and set the appropriate options
under System Management Options.

[1 NOTE
It is possible to configure temperature and voltage thresholds on the server
system using the SCU or SSU. However, the thresholds set with the SCU or
SSU arein effect only for a short time during the system boot process. PIC
overwrites these thresholds when the OS loads. It isrecommended that all
threshold changes be made using Platform Instrumentation Control (PIC).

Compatibility and Upgrade Issues

The following paragraphs describe compatibility and upgrade issues for:

e LSCandLDSM

NeWare

e Windows NT

*  Windows 98 Second Edition
* UnixWare

 RedHat Linux

e  Windows 2000

LSC and LDSM

If you have earlier versions of LSC or LDSM on your network, be aware of the following:

* Vesonsof LSC integrated with LDSM (e.g., LDSM with LSC55) are not supported
under ISC.

* ThelSC-managed server installation will not upgrade the DMI service provider or any DMI
database that is already installed on the managed server. However, if a service provider is not
found, I1SC installsa DMI 2.0 service provider.

* ThelSC server installation process installs the remote procedure call (RPC) transports (DCE
and ONC) if they are not available on the managed server.

* |SC shipswith the DMI 2.0s Service Provider for Windows NT. The2.0sversionisan
extension of the Service Provider that supports security. 1SC does not use those features, but
they are available under Windows NT for possible use by other DMI 2.0s-compliant software.
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NetWare

For installation on systems using NetWare, be aware of the following:

Connect as a user with supervisor rights when installing ISC to a NetWare server.

All NetWare servers require two manual reboots following the ISC installation.

The TiRPC runtime library for ONC RPC or a substitute file set for NetWarebx must be
running.

Windows NT

For installation on systems using Windows NT, be aware of the following:

Connect as a user with supervisor rights when installing 1SC to a Windows NT server.

The ISC installation program automatically reboots both remote and local servers as necessary.
Remoate Access Service (RAS) must be previously beinstalled on the consolefor if
connectivity will use a modem.

Windows 98 Second Edition

For installation on systems using Windows 98 Second Edition, be aware of the following:

A manual reboot is required following the ISC installation.
Remote Registry must be previously installed on the console.

UnixWare

For installation on systems using UnixWare, be aware of the following:

Connect asroot user when installing 1SC to a UnixWare server.

A plain text password must be enabled in the registry. If the password is not enabled, an extra
reboot following ISC installation will be required on each UnixWare server.

Vision FS must beinstalled, configured, and running.

Mcopy must beinstalled on each ISC managed UnixWare server. Pleaserefer to the man page
for doscp for download and install instruction for mcopy. Mcopy can also beinstalled by
installing the mtools package from Skunkware 7 CD-ROM.

A manual reboot is required for each server following the ISC installation.

The server automatically reboots following ISC installation.

By default, SCO UnixWare v7.1.1 systems have DMI access set to read-only. This setting prevents
ISC from changing sensor thresholds, enabling the watchdog timer, and executing other functions.
To alow ISC to operate correctly, DMI access write permission must be enabled. Do the following
to enable DMI access to write:

1

2
3
4,
5

Login as'root'.

Stop the DMI Service Provider (dmi stop).

Open thefile/etc/rc2.d/S89dmi for editing.

Changetheline $DM _PATH $@to $DM _PATH $@ - w.

Save thefile and restart the DMI Service Provider (dmi start).

This changeisvalid for all future sessions.

Installation Guide for the Intel Server Control 15



Red Hat Linux

For installation on systems using Red Hat Linux, be aware of the following:

* RemotelSC installation is not available.
» Additional steps arerequired to configure the Linux DMI service provider.
» Additional steps arerequired to configure the SNMP-DMI mapper.

Windows 2000

When upgrading to ISC 3.1, the previously installed service partition must be removed and
recreated using utilities supplied with ISC 3.1. The system BIOS must also be upgraded.

LSC, LDSM, Windows, NetWare, and UnixWare
Installation

The ISC package contains both the console and instrumentation software. To install, launch
ISCSetup.exeif it is downloaded from the web or Launch Binaries\Setup.exe if it isfroma
CD-ROM. Remoteinstallation for server instrumentation softwareis supported for

Windows 2000/NT or Novell server. The console software installation can only beinstalled
locally. Sdect all the server(s) to be installed and follow the instruction on the screen to continue.
After theinstallation is completed, reboot the server to complete the installation:

*  Each Windows 2000/NT server automatically reboots.
* Each NetWare, UnixWare, or Linux server requires manual reboot.

Login with system administrator access.

Verify the HP OpenView is not running.

Do steps 4 and 5 then skip step 6 if you areinstalling from the Software Kit CD. Skip to step 6
if you areinstalling from a download from the web.

At the console, insert the Software Kit CD into the CD ROM reader.

Run the program x:\binaries\setup.exe, where x in the drive letter of your CD ROM reader.
Run the program | SCsetup.exe from the |SC download directory.

Note this installation may require multiple server reboots.

wphpE

No oA

When installation is complete, view thefilelogfile in the install directory of each server and
consoleto verify that ISC installed correctly.

Red Hat Linux Installation

There are three steps to the Red Hat Linux installation process:

* Installing Linux DMI server provider
* Installing ISC
» Configuring the SNMP_DMI mapper
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Installing Linux DMI Service Provider

1. Insert the Software Kit CD into the Linux server CD ROM reader.
2. Mount the CD using either of the following methods:

«  Enter the mount command as follows:
nmount /mt/cdrom
» Usethe Disk Management utility. To invokethis utility click the Start button, select
System, and then select the Disk M anagement menu option.

3. Uninstall ucd-snmp if it has been installed previously withr pm —e.

[] NOTE

If you uninstall ucd-snmp, you must also remove all related snmp and
DMI packages. When you remove these packages, remove them in an
order that diminates dependency error messages. For example, if a
dependency error message appears, remove the package mentioned in
the error message. Continue removing the dependent packagesin this
manner until the error messages stop.

4. Install the DMI service provider package located in the \Software\L inux\dmisnmp directory on
the Software Kit CD by using the rpm command. For example, the following command installs
aversion of the DMI service provider package:

rpm—i dmsp-1.0-6.i386.rpm

5. Locateand install the ucd-snmp RPM, ucd-snmp-utils RPM, and dmi2snmp RPM packages.
These packages are also located in the \Software\L inux\dmisnmp directory on the Software Kit
CD. Usetherpm command to install each package. For example, the following three
commands install versions of these three packages:

rpm—i ucd-snnp-4.1. 1-15smnmux. i 386. rpm
rpm—i ucd-snnmp-utils-4.1.1-15smux. i 386.rpm
rpm—i dm 2snnp- 1. 0- 15.i 386. rpm

6. Reboot the Linux server after you have installed all the packages.

Installing ISC Server Instrumentation

1. Insert the Software Kit CD into the Linux server CD ROM reader.
2. Mount the CD using either of the following methods:
» Enter the mount command as follows:
mount /mt/cdrom
» Usethe Disk Management utility. To invokethis utility click the Start button, select
System, and then select the Disk M anagement menu option.

3. List the contents of the Software Kit CD and make sure the ISC install packages and scripts are
ontheCD. You can locate these packages in the /Software/Linux directory. Usethefollowing
commands to move to that directory and list the files:

cd / mt/ cdrom Sof t war e/ Li nux
S
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6.

Y ou should seefile names similar to the following:

i pmidrvr-2.2.14.6.1. 1snp-1.i 386.rpm
i pmidrvr-2.2.16. 22snp-1.i386.rpm
isc-3.1-1.i386.rpm

instal |l ne

Run the ISC install script from the directory you listed in the previous step by entering the
following command at the command-line prompt:

./installme

Follow the instructions on your screen. The script prompts you to read and accept a license
agreement. Next, the ISC install program determines the version of the Red Hat Linux kernel
running on your server and installs the right version of the IPMI driver on your server. The
script then proceeds to install the I1SC package (e.g. isc-3.1-1.i386.rpm) on your server. Incase
theinstallation of the driver fails, the script displays appropriate error messages and then
terminates without installing the ISC package.

Reboot the Linux server when the command compl etes.

Configuring the SNMP-DMI Mapper

Y ou must complete these steps if any SNMP management console (HP OpenView, CA UniCenter)
will manage the Linux server.

18

1

2.

3.

Verify that the dmi2snmp and ucd-snmp packages areinstalled. For example, thefiles
dmi 2snnp- 10- 15. i 386. r pmand ucd- snnp- 4. 1. 1- 15snux. i 386. r pmcould represent
the dmi2snmp and ucd-snmp packages, respectively.
Open thefile/ et ¢/ snnp/ snnpd. conf . You can use any available editor such as vi, emacs,
or alinux editor.
Add atrapsink line at the end of thefile for each management consol e that receives traps from
the managed server. Usethe following syntax when adding theline:

trapsi nk <myhost _nane. donai n. conp

Be sure to substitute appropriate strings for the host name and domain.
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Customizing NetWare Servers After Setup

Whileinstalling PIC, the configuration and Setup program installs Adaptec and L SI (Symbios)
SCSl, and Inte® LAN Adapter instrumentation on the NetWare server but does not enable the
instrumentation support.

To enable support for any or all instrumentation, you must edit the AUTOEXEC.NCF filein the
SYS:SYSTEM directory as follows:

Add theline:
rpsstart.ncf

beforetheline:

i sc_on. ncf

To enable the Adaptec SCSI instrumentation, remove the word REM from these lines:
REM | oad si nti nw. nl m
REM | oad si nti nw. nl m

To enablethe Intel LAN Adapter instrumentation, remove the word REM from thisline:
REM | oad e100bdm . nl m/auto

To enablethe LSl (Symbios) SCSI instrumentation, remove the word REM from this line:

REM | oad sinti nw. nl m
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Launching ISC

ISC can be launched from and can manage your server from one of these enterprise management
environments:

* LANDesk Server Manager (LDSM)

* HP Nework Node Manager

e CA-Unicenter TNG

Oncethe ISC application is launched from an enterprise management console, the management
console application can terminate, and 1SC will continue to operate normally.

ISC can be launched from and can manage your server from a stand-alone I1SC Console. ThelSC
Console can run as an executable program, as an ActiveX control within an Internet browser, or
within Microsoft Management Console.

LANDesk® Server Manager

The LANDesk Server Manager (LDSM) console dynamically builds its feature set when
communication is established with a managed server. If the managed server is running the ISC, the
LDSM console adds an option for “Intel Server Control” in the Tools branch of the LDSM
navigation tree. Select this option to launch I SC.

HP Network Node Manager

The HP Network Node Manager Consol e autodetects servers running the 1SC Server
Instrumentation software. The Console updates the server bitmap with an 1SC server icon for those
servers.

To launch the ISC applet, select an | SC-enabled server on the HP Console network map, and then
select the “Intel Server Control Applet” option from the Tools Menu. Alternatively, you can launch
ISC by sdlecting an | SC-enabled server on the HP console network map, clicking the right mouse
button, and then selecting the “Intel Server Control” option from the popup menu.

CA-Unicenter TNG
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The CA-Unicenter TNG Consol e autodetects servers running the 1ISC Server Instrumentation
software if you have enabled the ISC to CA discovery service. To enable discovery, you must start
the®Intel Tng-1SC AutoDiscovery” service. You can start this service from either the TNG
Unicenter “ Auto Discovery” dialog or from the Windows NT “ Services” applet.

The"Intel Tng-1SC AutoDiscovery” service creates anew “Intel Server Control” TNG object for
each server having the ISC Server Instrumentation software. That TNG object displays on the map
asachild of the“1SC World View” and as a child of the |SC-enabled server. You can view all

| SC-enabled servers under the“1SC World View.”

To launch ISC, right-click on an “Intel Server Control” icon, and select the “Launch ISC” option
from the popup menu.
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Stand-alone ISC Console

Use the stand-alone |SC Console to manage | SC-enabled servers without installing an enterprise
management console application. The environment is implemented as an executable program; as
an application within Microsoft Management Console; or as an ActiveX control that runs within a
“container” application, such as Microsoft Internet Explorer, versions 5.0 or later, or Netscape
Navigator, version 4.0 or later.

To launch the stand-alone ISC Consolein its own container, do the following:
1. Click Start, and then point to Programs.

2. Poaint to Intd server Control Tool, and then point to Intel Server Control.
3. Fromthe Start Menu in Windows, select Start->Programs->Intel Server Control->ISC-Console.

Launching the ISC Console with Internet Browsers

To launch the stand-alone | SC Console within a Web browser, do the following:

1. Runthelnternet Browser to be used as a“containe™” for the ISC Console.
2. Within the browser, choose File->Open.
3. Enter the ISC Console filename, specifying the full path to thefile:

%I SCPATH%\MNEMCAICNISC.HTM

The stand-alone ISC Console will be started as the active application within the default Web
browser.

Oncethe ISC Consoleis loaded, the location can be saved as a“Bookmark” (Netscape) or a
“Favorite’ (Internet Explorer) for easy accessin later sessions.
Y ou may also:

1. Locatethefileusing Windows Explorer, specifying the path:
%I SCPATH%\MINEMCMCAISC.HTM
2. Double-click on the filename to launch the control within the default Web browser.

[] NOTE

Netscape Navigator requires a plug-in for viewing ActiveX applications.
Onethat is known to work is ScriptActive', which is available from
Ncompass Labs, Inc. (see http://wwmw.ncompasslabs.com).
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Launching the ISC Console with Microsoft Management Console

To launch the stand-alone | SC Console within Microsoft Management Console (MMC), do the
following:
1. Froma Start Menu in Windows or from the Start->Run sdection, run MMC.
2. Within MMC, choose File->Open.
3. Enter the ISC Console filename, specifying the full path to thefile:
%Il SCPATH%\MNEM CMIC\ISC.MSC

The |SC stand-alone application will be started as the active application within MMC. You may
also:

1. Locatethefile using Windows Explorer, specifying the path:
%I SCPATHY%\MINEM CNIC\ISC.MSC
2. Double-click on the filename to launch the control within MMC.

[1 NOTE
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If you have not installed MM C on your consol e system, you can obtain it
from Microsoft at http: //mwww. microsoft.com/management/mmc/
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Platform Compatibility Matrix

Table ists 1SC features specific to hardware platforms. 1n the table, columns present grouped
platforms while rows describe specific features. More general features, which can consist of
multiple specific features, appear in bold type and span an entire row.

Table 1 Platform Compatibility Matrix

Features Platform
L440GX SRKA4 SBT2
SRPL8! SPKA4 STL2
1SP4400
Summary

e Servers with ISC 2.x
Features

¢ Complete In-Band
management from
ISC3.1 Console.

¢ Out-of-Band (OOB)
management —
Modem/Serial only

* No Service Partition

¢ Servers with ISC 3.x
Features

¢ Complete In-band and
OOB management
from ISC3.1 console.

¢ Service Partition

¢« Complete In-Band
management

*« No OOB management.
* No Service Partition

In-band Remote Management (OS based)

Desktop Management
Interface (DMI)
Instrumentation

1A32

¢ Windows NT SP6A,
2000SP1

¢ NetWare 4.2,5.1
¢ UnixWare 7.1.1
¢ Linux 6.2 SBE2

1A32

« Windows NT SP6A,
2000SP1

¢ NetWare 5.1
e UnixWare 7.1.1
¢ Linux 6.2SBE2

1A32

«  Windows NTSP6A,
2000SP1

¢ NetWare 4.2,5.1
¢ UnixWare 7.1.1
¢ Linux 6.2SBE2

Win32* Console
Platform Instrumentation
Control (PIC)

Yes

¢ Windows 2000
professional SP1

* Windows 2000
Advanced Server SP1

¢ Windows NT
Workstation 4.0 SP6A

¢« Windows 98

Yes

¢ Windows 2000
professional SP1

*  Windows 2000
Advanced Server SP1

¢ Windows NT
Workstation 4.0 SP6A

¢« Windows 98

¢ Windows 2000
professional SP1

«  Windows 2000
Advanced Server SP1

¢ Windows NT
Workstation 4.0 SP6A

¢ Windows 98

11SC v3.1is planned to support the SRPL8 server when the system rel eases
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Table 1 Platform Compatibility Matrix (cont.)

Features Platform
L440GX SRKA4 SBT2
SRPL8? SPKA4 STL2
1ISP4400
Out-of-Band Remote Management
Win32 based Direct Yes Yes No
Platform Control (DPC)
Console
Remote Management Yes Yes No
via Modem/Serial (Not available on L440GX)
(DPC over Modem /
Emergency
Management Port
(EMP))
Remote Management Yes Yes No
via Intelligent Chassis
Management Bus
(ICMB)
Remote Management No Yes No
via LAN
(DPC over LAN)
Sensor Data Record Yes
(SDR) No (SRPLS)
Field Replaceable Unit Yes
(FRU)
System Event Log (SEL) | Yes Yes No
Access No (SRPLS)
OOB Sensor access No Yes No
(Sensor Access limited
to partial set of sensors)
Power Control (Power Yes Yes No
On, Power Off, Reset)
OOB command for No Yes No
graceful OS Shutdown
Out-of-Band Alerts
Platform Event Paging Yes Yes No
(firmware) (Not available on SRPLS) (Not integrated with ISC
software)
Baseboard Management | No Yes No

Controller (BMC) LAN
Alerts (Platform Event
Trap)

(Not integrated with ISC
software)

2|SC v3.1is planned to support the SRPL8 server when the system releases
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Table 1 Platform Com

patibility Matrix (cont.)

Features Platform
L440GX SRKA4 SBT2
SRPLS? SPKA4 STL2
1SP4400
In-Band (Instrumentation based) Alerts
Network Alerts (Popup Yes Yes Yes
Messages)
DMI Indication Yes Yes Yes
SNMP Traps (via DMI- Yes Yes Yes
SNMP Translator)
ISC Paging Yes Yes No
(Not available on SRPLS8)
BIOS Console Redirection
Over Modem/Serial Yes Yes No
Over LAN No Yes No
Remote Boot/Access of Service Partition
Over Modem/Serial No Yes No
Over LAN No Yes No
Service Partition based features
Client System Setup No Yes No
Utility (SSU) (Remote
access)
Remote Diagnostics No Yes No
DOS Shell access No Yes No
(Command Prompt)
File Transfer No Yes No
Remote File execution No Yes No
Pushbutton remote No Yes No
upgrade of BMC
Firmware
Pushbutton remote No Yes No

upgrade of BIOS

% |SC v3.1is planned to support the SRPL8 server when the system releases
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Table 1 Platform Compatibility Matrix (cont.)

Features Platform
L440GX SRKA4 SBT2
SRPL8* SPKA4 STL2
1ISP4400
Enterprise Server Management Console (ESMC) Integration’s
LANDesk® Server Yes Yes Yes

Manager (LDSM) 6.1
(Linux/UnixWare servers
are not discovered /
managed by LDSM

HP OpenView Network Yes Yes Yes
Node Manager 6.1

CA Unicenter Yes Yes Yes
Framework TNG 2.2

Web Browser (Microsoft | Yes Yes Yes
IE 5.X, Netscape 4.71)

Microsoft MMC Yes Yes Yes
ISC Standalone Yes Yes Yes

*ISC v3.1 is planned to support the SRPL8 server when the system releases
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